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Licence Agreement

If the purchaser does not agree with the terms of this agreement then the 
full product should be returned for a refund of the purchase price.  Use 
of the software and associated documentation implies acceptance of this 
agreement.

CaRob Computing grants the purchaser the right to use one or more copies 
of this software within one campus of one organisation.   The purchaser 
may not rent or lease or lend the software.  The purchaser may not 
reverse engineer, decompile, or disassemble the software.

The purchaser may copy the written materials accompanying the software 
for use only within their organisation.

In no event shall CaRob Computing be liable for any damages, including 
loss of data, or any other special, incidental, consequential, or indirect 
damages arising out of the use of , attempted use of, or inability to use 
this software or accompanying documentation., however caused and on 
any theory of liability.   Under no circumstances shall the liability of CaRob 
Computing exceed the actual amount paid to and received by CaRob 
Computing in connection with the particular copy of JobCard.

CaRob Computing 
 153 Must St
 PORTLAND VIC 3305
 Fax: (03)  5523 5144

      email: carobcomputing@hotkey.net.au
         web:    www.carobcom.com
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ChapteR 1 - getting staRted



© CaRob Computing    Page 2 

Chapter 1

how to get staRted with JobCaRd

Read the overview - Pages 3...

Perform Installation - Chapter 6

Experiment with the sample data before setting up JobCard in your own 
way.

Read the Chapter 3 and Chapter 4 so you understand how JobCard 
behaves from a user’s perspective.

Use the Setup Guide (Chapter 2)  to configure JobCard your own way.

Make sure you set passwords
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JobCaRd oveRview 
JobCard allows service requests to be made on physical resources within 
your organsiation.  The requests can be directed to the correct service 
personnel, documented, and kept as history.  Requests may be in the 
nature of repairs or a request for some form of assistance or even a 
request to a lab technician to set up a science prac.

maintenanCe aReas

A Maintenance Area is a logically distinct operation with a specific 
coordinator and specific service people (who may be the same), who 
maintain distinct facilities.  For example: Physical Services or Computer or 
Science Department.

At least one Maintenance Area is required in JobCard.

CategoRies and ResouRCes

Within each Area, resources may be grouped in Categories.  A category 
usually has a specifically allocated default service person.  For example, 
Desktop Computers, Staff Notebooks, Admin Computers.

Each maintenance area requires at least one category.  Categories may 
contain specific resources or items such as individual computers.  This 
enables job histories to be maintained over time.

aCCess to JobCaRd

JobCard has three levels of access: Administrator, Servicer, and User  

Administrators

Administrators set up different maintenance areas, enter the resources 
that are subject to service, manage passwords and configuration options, 
set up scheduled maintenance tasks, do backups, data imports, program 
updates and so on.

Administrators can prioritise jobs, reallocate jobs between servicers, and 
do all that a servicer can, but across all maintenance areas.

Administrators should be people in charge of a lot of resources and who 
are competent with managing computer software and data files (and who 
are prepared to read this manual).  Computer coordinators and librarians 
are typically administrators.  

There may be one or more administrators, who communicate with each 
other, but manage their own maintenance areas.

Users

Users with a fault to report or wanting assistance run JobCard.  They 
select from a list of equipment or tasks, enter the request or problem 
from a standard list or in their own words, enter their user code and 
submit the job.  Jobs are placed into a list identified with a maintenance 
area and, optionally, a physical location.

Users may view the job list but not modify it.
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Servicers

Servicers see jobs relating to a particular maintenance area. 

 They may: 
 • print out selected jobs. 
 • write comment on jobs.  
 • save the job into a history file, or bin it.  
 • re-allocate jobs to other servicers.

Servicers can be computer support staff, audio-visual equipment 
technician, physical services coordinator; that is, anyone who is 
responsible in some way for maintenance of equipment or providing 
service.

A servicer logs into a single area, for example, Computers, and only sees 
the jobs and history that are Computer related. Another servicer may 
only see the Buildings area.  Different areas have their own password.

sCheduled maintenanCe

You may have tasks that should be done at regular intervals. These can 
be entered, given a date and a service interval.  JobCard will place the 
item into the Job Queue automatically.
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JobCaRd oRganisation
In order to categorise items and jobs, as well as being able to restrict 
views to users and servicers, some degree of organisation is required.  
Equipment and service requests belong to a category.  Different 
categories can belong to a maintenance area.

oRganisational hieRaRChy

Maintenance areas

Maintenance areas in JobCard are used to filter the Job list so that it 
shows only those items that are related to a servicer.  For example, you 
may have two areas: Computer Related and Library Audio Visual.

Each area is associated with one or more servicer and has its own 
password. Servicers log in to one specific area of JobCard. Servicers can 
belong to more than one area.

When the library technician logs in to JobCard, she sees only Library 
Audio Visual jobs and history. The computer technician sees only 
Computer Related jobs and history.
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Categories

Categories contain the specific service items or resources.  Their purpose 
is to create a hierarchical tree of resources to make it easy for users to 
find a specific resource.

Categories belong to a maintenance area and have a default servicer 
associated with them.
For example:  Desktop Computer may be a category

Resources (or items)

These are individual pieces of equipment (eg IBM03), or a service 
request (eg install printer), or a general item (eg miscellaneous)

Resources must belong to a category and may be given a location.  
They can be a given a different servicer than the one identified for their 
category.

Locations

Locations are a list of rooms or physical locations. Items can be given a 
location.  They useful to filter the tree diagram to only those items in a 
specific location.

This is what a user sees when submitting a job.  It shows 4 categories 
from 2 Areas.  The Area is not important to the user so they don't usually 
see it.

Users select a resource to report, or they may simply choose the 
category.
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initial setup
For your intial setup of JobCard, we advise that you keep it simple, 
adding more structure later.  

One maintenance area may be all you need. eg Computer Resources.

You might have only a couple of Categories eg Hardware and Software.  
Strictly speaking, you do not need any items in these categories.  The 
user selects a category, indicates the problem, and submits the job.  

This setup has two general categories and no specific items 

Usually however, categories need to contain some resources. The 
user has less information to enter and specific item histories can be 
maintained by JobCard.

Your initial resources may be generic or specific, depending on your 
needs.  A simple but workable setup is shown on the facing page and 
below.

In general, the larger the organisation and the more service people 
involved, the more structure that needs to go into the organisation of 
resources.

Different administrators in charge of different maintenance areas in 
JobCard will probably organise their categories based on totally different 
logic, all valid.  

The sample data above shows two Maintenance Areas, with Resources from the highlighted Category in the 
highlighted Area 
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Running JobCard

The installation will place a shortcut to JobCard in the Programs Menu 
and on the desktop.  You can also run Jobcard by running JobCard.exe 
from the installation folder.

User Access

The initial password is 1 and can be changed by admin.

JobCard initially opens as a user would see it.  

Administrator Access

Log on as Administrator from within the File Menu.  The initial password 
is 2 and can be changed after logging on.

Once logged on as Administrator, other menu and shortcut items appear.

While you are logged on as administrator, you will see the Administrator 
Icon on the toolbar.  

This is a reminder that you are using privileged access, and to log out if 
others may use that same JobCard.

If an Administrator Password is not set, all users who run JobCard will 
immediately have Administrator mode access.   

If JobCard is accessible over the network, ensure that there is an Admin 
Password.
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General Password

You may set a general password for anyone attempting to run JobCard.   
If the password is blank, no challenge is made.

Passwords are case sensitive

Demonstration Mode

The initial installation of JobCard runs in demonstration mode.  

Demo mode JobCard is fully functional in every respect except that file 
sizes are restricted.  Limits are: 10 jobs, 10 users, 2 areas, 4 categories, 
16 resources, and 10 history records.

Placing a single file SClient.tps into the JobCard folder authenticates the 
program and gives it your organisation name.  This file is obtained from 
CaRob Computing, usually via email when ordering JobCard.

Registration Code

If you choose to purchase JobCard, CaRob will forward a Registration 
Code that ensures that the software will operate permanently.  

Usually this code is faxed to you upon receipt of payment.  If this is not 
convenient, contact us via email, fax or phone and we will send the code 
some other way.

Enter the code from under the File Menu.  When the code is correctly 
entered, you can’t change it again.

Store the code safely so it can be used if re-installing JobCard

Set Logo

You may set your own logo.  It must be a .gif or .jpg format.

Go to Administration > Set Logo

Choose the new logo.  

It is your responsibility to adapt the logo if the size is not correct.



© CaRob Computing    Page 10 

Chapter 1

operaTional feaTures of JobCard
This section describes program behaviour throughout JobCard.  

Editing Data

JobCard requires data files be maintained.  Typical of these are 
maintenance areas, users, common faults, locations.  

JobCard usually displays the data in a browse table, 
as shown here.

Tables can be scrolled with scroll bars, arrow keys, or 
using <PAGE-UP> <PAGE DN> keys

The three buttons Insert Change Delete are referred 
to as Update buttons.

Update options can be selected by Right-
Clicking on most tables.

Updating the data calls up a Form within 
which data can be entered or edited.

Keystrokes on a Form

<TAB> moves forward through the fields.
<SHIFT-TAB> moves in reverse through the fields.

<ESC> will close any window

Windows Copy <CTRL-C>, Paste <CTRL-V>, Cut <CTRL-X> commands 
can be used in any data fields.

As soon as the form is closed with the OK button, the data is saved 
automatically, and the browse will show updated data.
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Using Locators in JobCard

Many of JobCard’s browse tables have a ‘Locate’ item near the top.  

This table has Locate User Code.

This indicates that you can commence typing the User 
Code and as you type each letter, the table scrolls 
automatically to the nearest match.

First, click on the table so it is the active screen control, 
then type the user code.

Note 'wsj' typed here.

The table has automatically scrolled to that user code.

This method is often more convenient than using arrow 
keys or the scroll bar.

Pressing the up or down arrow keys clears the 
currently typed characters, ready for another entry.

Reports and Print Preview 

Any job sent to a printer is referred to as a 'report'.

All reports will first appear on screen in a Print Preview window.

From here, you may choose to:

• Print all pages
• Cancel the print
• Print selected pages
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Printing selected pages

After choosing pages 1 to 5 here, you 
will be returned to the preview.

Then, when you click the print button, 
pages 1 to 5 will print.
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ChapteR 2 - JobCaRd setup
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befoRe CommenCing the setup

Pre-reading

Please ensure you have read the overview section of Chapter 1 before 
continuing.

Planning JobCard

Assuming you are new to JobCard your initial setup should be kept 
reasonably simple.   Modifications can easily be added later.

This chapter will follow the scenario described on the opposite page.
    

Where to go to start

All tasks described in this chapter can be accessed directly from the 
menu items, but to ensure that they are done in the correct order this 
chapter will follow the setup guide available from the toolbar.

When you are familiar with the system, the menu access is quicker.

Log in to JobCard as Administrator from under the file menu

Click the Setup Guide button 
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My Scenario

I am a computer coordinator at a school with a technician and an I.T. 
trainee.   We are responsible for a network, many computers, laptops, 
and printers. We also tutor staff and load software for them.  Computers 
are located in several labs and smaller 'pods' as well as staff rooms and 
the library.

I know JobCard will be handy for the library technician who is in charge 
of DVD players, projectors and other equipment. I know it would be 
perfect for Physical Services fault reporting. However, I am not going to 
worry about them for now. They can come on board as separate areas 
later.

I have read the Overview in chapter one and sort of understand it, so I 
am going to create a structure based on: 

Data Item Initial Values Comment
Maintenance Area Computer Area One will do for a start

Categories Computer-Desktop
Notebook
Printer
Software
Miscellaneous

Users Dilbert (IT Manager)
Jared (Tech)
Bert (Trainee)

These users will also be 
servicers. The rest of the staff 
may be imported later.

Locations Main labs: G1, G2, G11
Pods: Graphics, Media, Hums
Staffrooms: SR1, SR2
Library

Common faults Can't log on to network
Can't print
Software won't run
Dodgy mouse
Machine freezes

That will do to start. Add more 
later.
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the set up guide

The guide is a sequence that takes you logically through the setup of 
JobCard, with advice given.  Move between the windows using the finger 
pointers (top right).

The windows have one or more buttons that take you into the functional 
area of JobCard to perform the task.

Complete the windows in order.

set up guide 1  
Introduction and Data Removal

Click the button to Remove Sample Data 

Before removing data it's always a good idea to do a backup.

Click on the Back up Existing Data button
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Backing up Data

Backing up the program files as well as data provides a full working copy 
of Jobcard in the folder designated.

It's the simplest way to copy a working installation anywhere on the 
network.

Note that the folder dialogue window allows you to create a new folder.

Deleting Data

After backing up, perform the deletion.

Check which items have been ticked, then click the Delete 
button to clear the data.  

This is a serious step so you are prompted twice to be sure.
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set up guide 2  - maintenanCe aReas

Click the Check Areas button

There are no areas if you have cleared out all data.

Click Insert to bring up the entry form...

   Enter "Computer Area" and press OK

You could add a password to this area if you wanted although if 
you use only one maintenance area it is not really necessary, if 
the administrator is to look after that area.

You now have one Area but may have as many as 
you like.

When you have designated one or more users to be 
service personnel, you may assign them to this area, 
but ignore it for now.
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set up guide 3  - useRs and seRviCeRs

You may directly enter users 
or import them from text file.

Direct Entry of Users

Enter users directly if you are not adding many.  Import via a file is best 
when adding many users.

Click on Edit Users

Enter servicers first, for convenience

Insert Dil, Jared, and Bert... (use your own)

Tick Is Servicer so that JobCard knows these people are 
servicers.  

If you want these people to receive email notifications, complete the 
email fields.

When done, your user table should look similar to above.  Note that 
servicers are indicated with a small screwdriver image.
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Set up Guide 3  - Users and Servicers (continued)

Import Users

Import is the recommended way of importing a large number of users, 
as long as they can be organised into a text file. The text file must be 
named "staff.txt" and have the format displayed on the window here.

Use the ... button to lookup staff.txt.  It can be in any folder.

The View Staff.txt button lets you view and check the contents.

When satisfied, Click the Import button

After importing, open the browse table and tick the 'Is Servicer 'box for 
anyone who needs to be servicers.
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set up guide 4 - assign seRviCeRs to aReas

Servicers must be in the user list, and marked as servicers (previous 
step).
Servicers can be associated with one or more Maintenance Area.

Click the 'Servicers and their Areas' button

Currently the Computer Area has no servicers.

All potential servicers are 
shown in the right hand 
table.

All three of these 
characters are going into 
the computer area, so use 
Drag'n'Drop or highlight 
them and use the button.
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set up guide 5 - loCations

Locations are not compulsory.

However if you have many equipment items, scattered through many 
locations, it is advisable to use locations.

You can have several labs with equipment from PC's, Printers, DVD 
players, Multimedia Projectors etc. Having a location allows the user to 
filter the resource list to a single room when submitting a job.  It can 
assist the servicer to find the faulty item.

Edit Locations

Directly enter locations if you don't have too many.

Import Locations

A plain text file of rooms or locations can be imported directly.  
Shown here in Notepad.

The file must be named "Room.txt".
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set up guide 6  - CategoRies and ResouRCes

CategoRies

A Maintenance Area must have at least one category, and will usually 
have resources.  However Jobs can be submitted on the category 
alone or you may choose a resource name that is quite generic such as 
Software Install or Printer.

Servicers Note

You should allocate a servicer to each category and may allocate one to 
specific resources.  When a job is submitted, the request will go to the 
specific item's servicer if one has been set, otherwise the job will go to 
the category's default servicer.

Resource Specific servicers need only be set where they are different to 
the category servicer.

Use the edit buttons under Category to add one or more categories and 
set their default servicer and other options.
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You may change the 
Maintenance Area any time 
using the lookup button.

Use the LookUp button to 
choose a Servicer.

ResouRCes

A Resource can be used to refer to any potential service request within 
the category. Often that relates to physical equipment, but it can be a 
service such as training.  'Item' is a more general word, often used in this 
manual, which means the same thing: something that comes under a 
category.

You do not have to have resources entered.  A user can select a category 
and describe their problem.

However entering specific items means less typing for the users if they 
can directly select their item.  Also, the history file becomes more useful 
when it can display service histories of given items.

Adding a Resource

Highlight the Correct Category

Press Insert (next to the 
Resources table)

Enter the item's name or 
identifier.

A description helps a user 
to identify items.  It displays 
when a user submits a job.

The default servicer has been 
inherited from that of the 
category.  Change it if you 
wish.

The Location can be looked up 
by clicking the lookup button.
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Cloning

Many computer labs have equipment identified systematically.  
Eg computers 1 to 26 in room G1 labelled from G101 to G126.  

Cloning allows computer G101 to be entered with all relevant details, then 
replicated automatically from G102 to G126, saving lots of time.

Here, G101 has been added, through the update form.

With G101 highlighted, the Clone button is clicked, bring up the Clone 
dialogue window.  Filling in the details...

The stem is that part of the name that does not change (G1).  The first of 
the copies is to be called G102, so the starting number is 2. I want to go 
to 26, so I need to add 25.

If you get the arithmetic wrong don't worry because you can easily add or 
delete extras.

Click the Make Clones button

The copies are instantly created, identical in every respect except name 
to G101.

The Undo Clone button is now active and will function until you clone 
another resource or until you close this window.

If you need to undo the cloning, do it immediately.
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Changing a Resource's Category

In this example I have a Welfare Computer in Miscellaneous when I 
wanted it in Computer-Desktop.

Click the Move 
Resources button

and bring up this utility window.

Now I can highlight the Welfare Computer on the left, and drag it to the 
highlighted category on the right.

The welfare computer now belongs to Computer-Desktop.
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set up guide 7 - list of Common seRviCe Requests

This assists users by making it easy to select common faults and allows 
the history file to be used more analytically because faults are described 
in the same way and thus can be summarised more easily.

Click the Edit List of Requests button

Edit this list to suit your needs.  Each fault is given a code automatically.   
This code is passed though to the history file and helps with summaries.
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set up guide 8 - sCheduled maintenanCe tasks

Scheduled tasks are placed into the Job Queue whenever they are due.

Click Edit Scheduled 
Tasks

Click Insert to get the Update Form

Fill in the appropriate details

Date of Last Maintenance can be left 
for JobCard to complete.

Click OK

When the correct time arrives, the job appears in the queue.   

When the Job is dragged to the history file, JobCard regards the Job as 
having been done and updates the Date of Last Maintenance field (in the 
above form).  It then resets the next maintenance date.
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set up guide 9 - ConfiguRation options

Use Maintenance Schedules

If unticked, JobCard will not add any Scheduled Maintenance tasks.

Allow users to View Submitted jobs

If unticked, Users cannot view the Job queue.

Allow servicer final comment...

This encourages servicers to add a comment to jobs that go to history, 
by opening up that job in a window. Otherwise the job goes to history 
directly.

User Code must be chosen...

If ticked, you must be prepared to have all staff names entered in the 
user list.  This may require you to import the users' names via a text file.
You must maintain this list as users change.

Passwords

If the JobCard password is left blank, no password is required for users.

If the Admin password is blank, Jobcard automatically opens in Admin 
mode.  This is useful for setting up, but not when JobCard is on the 
network.
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set up guide 10 - data CheCk

Click the Check Data button to bring up this window

The data check checks the logic and 
completeness of your current data.

Click the button to run the check 
and view a report.

The report is a plain text file 
"errors.txt" and can be printed 
using the button on the window.
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email

Overview

JobCard may be configured to send an email to the servicer when a job is 
submitted.  The job still goes into the usual job list, but the servicer will 
receive email notification of it straight away.

When viewed by a servicer, the job can be allocated to another servicer.  
If that servicer has an email address, he will be notified via email.

When a job is moved to history, if both notifier and servicer have email, a 
Job Completion notification email may be sent to the notifier.

Configuration requirements

An email address must be configured for use by Jobcard to send from.
You must test that it works.
Servicers must have an email address entered into JobCard and must 
have their email enabled. 
General users may have email addresses entered.

Set up Specifics

From the Administration Menu, select Email Configuration.

Tick Email servicer when job is submitted to activate the relevant 
controls.

Check either All Users or Selected Users.  

Click Set User 
Status to edit 
individual mail 
settings.

(see over)
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Set User Email Status

For designated servicers:

Check Allow Email by clicking the Toggle button. 
Enter an email address by Double clicking an entry.  This allows you to 
enter the email address directly on the line.

Alternatively

Edit the User Details in the menu: Browse Edit > Users.

or 

Import email addresses from menu: Import >  Import User Names.
If users already exist, the import process updates their details.

When you have a couple of servicers set up correctly, return to 
the Email Configuration Window.

Click Edit Settings
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Email Settings

Domain

Usually not needed

Server and Port

The name of your email server and its port.  SMTP mail defaults to Port 
25, but yours may be different.

Authorised User Account Name

General email usually does not require an account name in order to 
accept an email.  In this case, leave it blank like the above example.

Managed Servers such as Edumail in Victoria will not accept email unless 
it is from an authorised user with a password.  In this case, you must 
enter an account name and its password.  Depending onhow the server 
is configured, the account name may simply be the name eg tom, or it 
may be the full account name tom@edumail.vic.gov.au.  It is matter of 
trial and error in this case.

Default User

This is an account to attach to an email as a sender if the actual sender 
in JobCard does not have a listed email account name.  It can be left 
blank, but without it, some emails are treated as junk mail.
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Test Message

Click the Send Test Message button

This window asks who to send the email to.

Clicking the ellipses (...) button will bring up this 
window with all of your designated servicers.

Select a servicer (probably yourself)

Click Send

If your basic configuration settings are OK, you will see a message 
‘Sending 1 Email’.  The window should close itself after a short pause.

If you have things entered correctly you will receive an email looking 
similar to this:
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Try an actual job

For an email to be sent, you must have:

  Activated Email
  The relevant servicer must be Email Enabled  
  The relevant servicer must have an email address

'Send' will always add the Job to the usual queue and if the above 
conditions are satisfied, will also send an email.

The email contains the message plus details of where and when the 
email originated.

Emails will also be sent to the notifier if a servicer is changed or a job is 
moved to history.
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ChapteR 3 - useR guide
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the useR guide

Note

Often software gets ahead of a printed manual, so if things don't look 
exactly the same, that's ok;  the main process won't have changed.  If 
you are not sure what an undocumented button or option does, try it out.

what JobCaRd does

JobCard lets you alert someone about a problem you've noticed or submit 
some sort of service request.  

Typical situations:
 • a fault with some equipment, often computer related
 • software installation or update required
 • report a broken window

You select from a list of equipment or tasks, report the issue from a 
standard list or in your own words, enter your user code and submit the 
job.  

The job is added to a job list where service people can view the jobs, 
prioritise them, print them, annotate them, and store them in a history 
file, once completed.

You can view or amend the job list if your JobCard administrator has 
allowed it.  You can see whether a job has been read by a servicer, or 
read any notes made about it.

Jobs may be submitted through Windows or via a web browser.

windows

One or more people in your school will administer JobCard and someone 
will have placed (or can place) a shortcut on a computer available to you.  
You must be connected to your network because JobCard is on a server, 
not on your computer.

Double-Click the shortcut button on your desktop

If the JobCard administrator has implemented a password, you will have 
to enter it.  It is case sensitive.

Enter your password and Click OK
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Click on the pencil icon   to submit a job.
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the seRviCe Request window

After submitting the job a window displays.  Click OK.

If email options have been activated, the service person will receive an 
email.
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Click binoculars to View current jobs (below)

You may double click any job to see the details and to see if a 
service person has added any notes.
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bRowseR 
You will probably have a hyperlink from your organisation's intranet.

Click Login

Enter the password, which is case-
sensitive.

seleCting a ResouRCe oR CategoRy

You will submit service requests through one or more Maintenance Areas 
each grouped into one or more Categories of items or resources.

This example shows Physical Services highlighted in yellow, which has 
four categories.   Classroom category is highlighted, and it displays 
specific rooms as resources on the right.

If the specific resource 
you want is listed, click the 
pencil button next to it.

If the individual item 
or resource is not 
listed, select the most 
appropriate category.
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Job window

You have only two fields to complete.  
Try to be as specific as you can in the description of the problem. 

After clicking 
save, you will 
be taken to the 
View Jobs page 
where your job is 
highlighted.

You can always view jobs that are currently active.

Email notification
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oveRview
A servicer is anyone who logs on as an Administrator or who logs in to a 
Maintenance Area.  Areas can each have different passwords.

An administrator sees all maintenance areas and can maintain all data 
files.

Anyone logged into a single area can service jobs, view histories and set 
maintenance schedules for that area.

The focus for a servicer is the job list.  The flow chart next page 
summarises their actions as far as Jobs are concerned.

A job may be a mistake or other trivia and can be dragged to the bin.

A job may be better done by another servicer, so it can be reallocated.

Jobs remaining must be dealt with by the servicer.  
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the histoRy file

Someone has to decide on how or if the history utility is to be used.  It 
may only be used for certain kinds of job, all jobs or no jobs.  This is an 
in-house decision.

When a job is completed, the servicer either bins it or drags it to history.  
If it goes into history, the servicer can add a comment to about what 
action was taken (for future reference).

Jobs can be restored from the history file if they have been placed there 
prematurely.

The history file can be viewed, printed, and 
exported as a text file.  It can be a useful 
tool for looking at the work history of specific 
pieces of equipment to assist in decision 
making with regards perhaps to disposal or 
renewing.

The Bin

The bin is not permanent deletion.  It actually 
saves each job. If the bin is emptied, though, 
the job is gone.

Jobs can be restored from the bin if they have 
been placed there prematurely.

The Job List

This can be read by users if the administrator 
has allowed it.

If a machine is sent out for repair, the 
repairer can be entered. The job stays in the 
list until completion, but anyone checking the 
list can see what's happening to it.

If a job is taking time, a checkbox can be 
ticked to indicate that work is in progress.  
This reassures users (and the boss maybe) 
that some action is ocurring.
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woRking with the Job list
Log in to an area with the Area password

After logging in

Click this button to see the jobs from your area.
    

Current Jobs
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Sorting Jobs

The job list shows jobs in chronological order initially, but a single click on 
any heading sorts by that column.  Another click sorts in reverse.

Triangle Icons

The jobs may have coloured icons on the left.  

In particular, a red triangle means a job is fresh.  It 
hasn't been opened by a servicer or administrator.  A 
yellow triangle indicates that a job has at least been 
opened.  No icon means that a servicer has flagged it 
as being looked at.

The symbols are partly to give some feedback to users 
who want to see where there job has got to.

Show all jobs or Show one servicer's jobs

If Show All Jobs is unticked, you can see jobs for a selected servicer only.  
The little table at left of screen shows all servicers for that particular 
area.

All of the above applies to administrators except they see jobs and 
servicers from all maintenance areas.

Change Table 

Drag the column boundaries to resize columns.
Use the List Box Font button to alter the font size or type.

These settings are remembered.
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Viewing a Job

Click the View... button  

1. Change Item Name

Not usually required but if the job has it wrong it can be corrected.

2. Edit problem

Not usually required but it can be edited.

3. Set a priority  

This may be set by a supervisor to indicate importance.  The printed job 
list puts high priority jobs at the top.

A priority 5 job has a red button placed on it to attract attention.

Priorities translate when printed as follows: 
5 - High, 4 - Medium High, 3 - Medium, 2 - Medium Low, 1 - Low
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4.  Turns off yellow or red icon 

Shows someone may actually be doing something about this job.

5. If external servicer is involved

External servicers can be looked up from a list.

6. Notes area
The message shown in the screen dump is what occurs if someone has 
reallocated the job to the current servicer.

This area is where a servicer can annotate a job prior to it going into 
history.

7.  Reallocate the job

The hooked arrow indicates a lookup table, where you can choose 
another servicer for this job.

8. Unique Job Number

Can be convenient for someone to be able to say "I'm working on job 68" 
rather than "I'm working on that S105 job that Jared dumped on me."

9. Send Email

JobCard can send an email directly to the Job initiator.  You may add an 
attachment if there is a diagram or image that is relevant.
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Printing Jobs

Click the Print... button  

This window allows you to choose jobs to print.  You may tag/untag jobs 
individually or use the buttons.  The Fresh jobs buttons will tag all jobs 
with red or yellow triangles. These are the jobs not being looked at yet.

When the jobs are printed, the Being Looked At checkbox is automatically 
ticked, and the triangle icon disappears.

The jobs appearing in the table above are based on whether all jobs were 
being viewed in the job list, or whether only a selected servicer's jobs 
were being viewed.

The above image has All Jobs printed above the table.

If the job view was of Jared's then the print window would differ as 
shown below.
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When printed, the jobs print 5 to a page, showing jobs in priority order.  
Some room is left for a servicer to make any notes.
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Job's done

When a job is not wanted in the list, it is either binned it or sent it to 
history.

The Bin

The bin removes the job but does not actually delete it.
This is mainly in case a job is mistakenly binned and needs recovery.

Double Click on the bin to open it...

The bin is viewed like any other file but cannot be edited, printed, or 
exported.

Double Click a job to put it back in the job list.

Drag 'n' Drop

Drag  means:  
...click on the job to be moved 
...keep the mouse button held 
down
...move the mouse to the bin or 
history file.

Drop means: 
...release the mouse button over 
the target
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Dragging to history and annotating the job

If set up this way by the administrator, when you drop the job on the 
History icon, the job immediately opens in the edit form....

The servicer can then 
make a final note of what 
was performed.  Other 
items can also be edited 
if needed.

Click OK to add it to 
history, Cancel to return 
it to the job list.

If email is functional in JobCard, an email notification is automatically 
generated for the job initiator



© CaRob Computing    Page 56 

Chapter 4

Back on the Job List Window

Double Click the icon to open the History 

The History Window

If logged into a Maintenance Area, you see the history for that area.   
If logged on as Administrator, you see the history of all areas.

The view can be filtered to a specific notifier or a specific servicer, at left 
of window.

Export to Text

This exports all history fields to a text file named "history.txt".  This gives 
you the flexibility to open it with another tool (e.g. spreadsheet) and 
manipulate it yourself.

The file can be viewed after 
exporting.
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pRinting histoRy

The History is likely to be too large for you to want to print all of it, so 
the printing is always filtered to a set of selected jobs.

Based on highlighted job

If you are interested in a particular item of equipment, or a particular 
servicer, or a particular notifier, highlight a job that involves them.  Then 
click the first of the print buttons.

Set the date range.
If you click Job Name, you will print G11_12 jobs.
If you click on Notifier, you will print Robert Wagner's jobs.
If you click on Servicer, you will print Jared Clarkson's jobs.

Based on Job Duration

Job duration is the period between when a job was reported and when it 
was added to history.
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sCheduled maintenanCe
When logged into a maintenance area, you may schedule maintenance 
tasks for that area.

Scheduled Maintenance is accessed from the Jobs Menu.

This screen dump shows a scheduled task going in for the area Computer 
Related.  The user cannot change the area.

This job will be added to the job list on the Next Scheduled Maintenance 
date.  

When the job is dragged to History, the Date of Next Maintenance is 
automatically updated  based on the service interval, and Date of Last 
Maintenance is filled in automatically.

This shows the Science task having automatically been set for 7 Oct after 
it was dragged into history for 7 Sept.
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JobCaRd’s files
The listing shows all files associated with JobCard.

JobCard is written with 
a database development 
language system called 
Clarion.  

Clarion uses a proprietary 
data file format identifable 
by the .tps extension. 
Each physical data file 
holds one logical data 
table together with its 
indexes. 

TPS files cannot be edited 
directly with common 
tools.

Restoring from a backup

To restore data from a backup, use Windows Explorer to copy the .tps 
files from your backup folder into your working folder.

Program Updates

The program will change with features requested by users, extra reports, 
bug fixes and so on.  No commercial software is static.

Updates to JobCard will be posted at 
http://www.carobcom.com/download.htm
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 RepaiRing data files
TopSpeed files are very robust and problems are rare.  However, power 
glitches for example can partly corrupt files.  A corrupt file is usually 
indicated by the program not running, but showing a message saying 
that C60TPSx.dll is having a problem with a file.  The file is usually 
named.

This is ideally fixed by having a recent data back up from which to 
restore.  However this is not always possible.

TopSpeed provides a freely distributable utility called TPSFIX.EXE 
which is part of the JobCard installation.  It is located in the folder 
JobCard3\FIRSTAID.

TPSFIX can work on a TPS file and repair it, copying it to a file with an 
extension of .TPR.  

This process does not always work if the header area of the file is 
damaged, so a further measure is provided.  All of the major JobCard 
data files have an Example file in the FIRSTAID directory with an 
extension .TPE.  Given a .TPE file to work with, TPSFIX can tell what the 
file format ought to be, and do its best to produce the .TPR repair file.   

After TPSFIX has run, producing a TPR file, the corrupt TPS file should be 
copied to elsewhere, the original deleted, and the TPR file renamed as 
TPS.  Then try it with JobCard.

TPSFIX Example

Assume that History.TPS file in C:\JobCard is corrupted.  

• Run TPSFIX.EXE.

This  window appears, asking for the the file to recover.  

Browse and locate your History.TPS

The recovery file is suggested as History.TPR.

Accept this.
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• Press Next and this screen appears asking for the location of the 
example file.  Note that this is optional, but recommended.

The Locale file is not used.

• Select Start

If the file is not corrupted, TPSFIX 
will tell you that it thinks the file is OK and allow you to exit. 

After repair,

• Remove the suspect History.TPS 
• Rename History.TPR to History.TPS.

Note that TPSFIX comes with its own Help file which can be referred to.

TopSpeed does not recommend using TPSFIX on files that are not 
damaged.
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JobCaRd.ini

JobCard.ini is a plain text file that saves window information, including 
locations and fonts.  If you move a window, its location is stored in it in 
this format:

 [BrowseLocation]
 Maximize=No
 Minimize=No
 XPos=96
 YPos=9
 Width=227
 Height=246

JobCard.ini is kept in the User's Documents folder of each computer in 
the sub-folder CaRob\JobCard

If a window does not appear when expected, it may be that the location 
of the window is off screen.  In this case, delete JobCard.ini from the 
My Documents\CaRob\JobCard folder.  All windows will then be in their 
default locations.

To find the JobCard.ini file, go to C:\Users\ and follow the folder tree as 
below, except using your own logged on user name.

Alternatively, find it through Libraries > Documents
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data baCkup and RestoRe
It is important that data be backed up securely. 
You probably have full system backups that can recover lost files, but 
these are not always easy to use, especially if the JobCard Administrator 
is not a system techie.

There are three options under the Administration Menu.

Back up data to another Folder

This copies all the .tps data files into another folder 
that you select.   It has the option of also saving 
program files.

There is no associated Restore with this backup method because 
restoring is done by copying one or more files using Windows Explorer.

If for example a file became corrupt and you did not want to (or couldn't) 
repair it, you could copy that file back from the backup folder.

It is a good idea to do this backup when ever you have made changes to 
your setup, e.g. after adding new resources or categories.

Back up data to a Single File

This backup saves all data .tps files into a single data file named JCData 
xxxxx.tps where  xxxxx is the date and time.

The advantage of this 
method is that you can have 
many copies of your data, at 
different dates.

The single data file is also 
easily copied to a memory 
stick or attached to an email.
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Restore Data from a Single File

Because you cannot over-write data 
files that may be open with another 
network user, this option requires you 
to perform it through the JCLock utility.

Run JCLock.exe (in the JobCard folder).
The Admin password is required.

the JCloCk utility

This utility displays all users on the Network currently using JobCard.  
When performing a data restore, all users need to be out of the program. 

You may shut them down using the buttons on bottom right.
To keep them shut down you might Disable JobCard (Centre Left).

You may then Restore Data from the Single File backup you select.

This restores the single file backup described previously or one created 
by the Automatic Backup (next page). It takes an image of each .tps file 
from the backup file and copies it over the existing file.

After restoring, make sure JobCard is Enabled.

Also use JCLock when you are updating the program with a new 
download from the CaRob web site.
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automatiC baCkup
JCBackup.exe makes a backup of JobCard data whenever it is run.
When executed, it makes a backup and closes itself.  You will see 
nothing.

Set JCBackup to run in Windows Task Scheduler

When your JobCard is functioning on a server, go to that computer and 
run Task Scheduler (TaskSchd.msc).

You may Create Task yourself, or import from the .xml file supplied in the 
JobCard folder (described below).

Import a task.

Select JCBackup.xml from the JobCard Folder.

Task Scheduler will open the task and allow you to edit its properties.

Check each tab in turn.

Triggers

Triggers determine when the backup is run.
Adjust to suit.

Actions

Check this carefully and Edit the action.

Your path may be different.

'Start in' is not optional as suggested by 
Windows.  Set it correctly.

After saving the task, make sure you run and test it.
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 JobCaRd setup

Installation 

Run the downloaded jcsetup.exe program.

It will offer to install JobCard to  C:\JobCard3.  Change this to anything 
that suits.

Install the sample data unless you have good reason not to.   
This gives you data to experiment with and it can be easily deleted.

This folder can be copied anywhere on your network and as long as users 
are given full control permissions.

Your initial installation could be to a local C: drive to experiment with.  At 
any point, you may copy the folder to a server with all data intact.

JobCard comprises a set of ISAM data files operated on by a Windows 
executable program.  

All files are located in a single JobCard folder.

The program and files are shareable so that any number of users on a 
network can run the program and work with the data at the same time.

If the JobCard folder is on a network, and users have access rights to the 
folder, they may operate JobCard. If NetJobCard browser access is being 
used by job reporters, only the Administrator and servicers need full 
permissions.

JobCard does not modify the system registry.

Permissions

Anyone running JobCard.exe needs to be able to Read/Write/Create in 
that folder.  Users accessing via the browser do not need permissions.

JobCard programs installed

JobCard.exe

Main Prgram for administration and job submission under Windows.

JCBackup.exe

Creates a single backup file containing all data, with no user input.  
You see nothing, it just does it.  Recommended to be installed under 
Windows Task Manager to run Daily.

JCLock.exe

Displays JobCard sessions, allows them to be closed, can disable JobCard 
and can perform data restore from the single file backup.

NetJobCard.exe

Runs as a web page server to allow users to submit jobs via their 
browser.  Usually installed as a Windows service.

JCMgr.exe

Installs and uninstalls NetJobCard as a Windows Service.
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Desktop Shortcuts

Administrators and servicers require a shortcut on their desktops.  
This should point to JobCard.exe.  Make sure you set the Start In folder.

Administrators also need a shortcut to JCLock.exe so they may start and 
stop JobCard.

If you are installing NetJobCard, users can use a browser to submit jobs 
and will not need desktop shortcuts. 

If not using NetJobCard, give users the shortcut to JobCard.exe

updating JobCaRd
Minor updates and bug fixes may be available gratis from time to time 
on our website. They will be available at http:/www.carobcom.com/
download.htm
Updates are actually a full fresh program install, not a patch.

1. Download a fresh setup program.
2. Backup your data on JobCard.
3. Run JCLock to prevent users accessing JobCard or to shut them down. 
4. Run the setup program, choosing NOT to install Sample Data 
5. Run JCLock again, allowing access.
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RegistRation details
The initial setup of JobCard will run in Demonstration Mode, with 
somewhat limited functionality.

Within these constraints however, any data you set up is worth setting up 
correctly because it will not be lost.

The Client File

Contact CaRob with an order number and return email address to receive  
a client file SClient.tps.

This encrypted file contains your school or organisation name and sets 
the mode to be Full (not demo).

Until CaRob receives payment, you may log in and see a nag screen.

Enter Registration Code

When payment is received, a registration code is sent to you. 
Enter it from the File Menu. 
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what is netJobCaRd?
NetJobCard is a browser based module for submitting job requests that operates on the same data as 
JobCard.  Setup and configuration are done with JobCard.  

NetJobCard is an executable program that is usually installed as a Windows Service on the JobCard 
server.  

JCMgr.exe installs and uninstalls NetJobCard as a service.

advantages of netJobCaRd oveR JobCaRd foR Job notifiCations

Users are not limited to Windows workstations.  Any browser on any •	
platform will work.

You have the potential to be able to make bookings from outside your •	
LAN via the internet.

Users do not require access to the JobCard data folder, so data is •	
protected.

Data is modified by the NetJobCard Server on the server, not via a •	
network transaction. Network transactions carry a small but real risk 
that they may not fully complete a disk write due to communications 
disruption.

Performance is better because data files don't travel to the client.•	

Users don't require desktop shortcuts, just a link on the intranet. •	
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ConfiguRing netJobCaRd

Run JCMgr.exe (the Admin password will be required).

Setting the Port

Click Change Port

If Port 1087 is used by another service then 
it won't work for NetJobCard.  

To see ports currently being used, run the command prompt and enter:

    netstat -an |find /i "listening" 

as shown below.

The second column of the listing shows the ports (after the colon) being used.  

If Port 1087 is used, choose another e.g. 1090

If you change the port,  restart NetJobCard

The Port number is saved in a configuration file Settings.ini in the JobCard folder which may be edited in 
Notepad if necessary.

When NetJobCard starts, it reads this port number from the .ini file.  After that, changing the port won't 
affect NetJobCard unless you Restart the service.
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Chapter 6

testing netJobCaRd

To test NetJobCard, run the executable NetJobCard.exe 

In Windows 7, the firewall prompts with a warning on the first running and you have to allow access. 

You may receive this type of message and need 
to update your firewall exceptions.

Server 2008 firewall does not give a message. 

Add a port exception to the firewall. 
(Accessed from Administration Tools > Windows 
Firewall with Advanced Security)
Set a new inbound and outbound rule for 
the program - select NetJobCard service 
(NetJobCard.exe) from the JobCard3 folder.

Once NetJobCard is running, check if a browser can find it.

From another computer, open a browser and enter the server's IP address and port e.g. 10.74.21.11:1087 
or http://servername:1087

If the browser is on the same computer as NetJobCard use 127.0.0.1:1087 or http://localhost:1087/

If it fails, and you know that the port is not being used by another application, check the proxy exceptions 
(next page).

When you know it is working, close NetJobCard and install it as a service
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Installation

pRoxy exCeptions

If you run a proxy server, then client browsers will need to have an exception added for the NetJobCard 
server, if one does not already exist.  You may do this with a group policy or by editing individual 
machines.  Editing the exceptions is shown below for IE.

For Internet Explorer, go to Tools > Internet Options > Connections Tab (left)

Then LAN Settings (below)

Then the Advanced button...

Enter the IP address of the NetJobCard server 
here.

6
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Chapter 7

installing netJobCaRd as a seRviCe

Run JCMgr.exe

On later Windows (e.g. Windows7) you need to Run as Administrator or it won't be able to install a 
service.

Click Windows Service Manager and keep it open.

Windows Service Manager (Win 7)

Click Install and Start As Service on the JCMgr window.
The expected behaviour is a slight pause, and the JCMgr window closes.  This indicates that the service 
has installed.

On the Windows Service 
Manager, go to Action menu > 
Refresh

You should see "NetJobCard" 
as a service.  
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NetJobCard
Disable the Window

We don't want the Web Server to be displaying a window on the server 
console.

In the Service manager, 
go to the Log On tab in 
NetJobCard Properties.

Uncheck 'Allow Service to Interact with Desktop'  and 
OK it.

Changing the NetJobCard Port

You do not have to remove NetJobCard as a service to change the port. 

Run JCMgr.
Change the Port and close JCMgr.

Restart it using the Windows Service Manager.

7
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Chapter 7
Removing the NetJobCard Service

This is a 3 step process.

1. Run JCMgr.exe
2. Run Windows Service Manager

Use the Right-click menu to Stop the Service

Keep the Service Manager open

3. Return to the JCMgr and close the window.

Go to the Service Manager, Action Menu > Refresh, and NetJobCard should be no longer in the list.
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NetJobCard

7


